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Billing Module  
 
 

 Enhanced Look and Feel 
• Standard Font size of 12 and Screen Resolution of 1024*768:  Running at this 

font size and screen resolution allows e-Medsys to display additional data on 
your screens. If your computer is not already set at this resolution we are 
encouraging you to switch to this resolution.  

 
• New Default Color schemes:  Our default color schemes have been updated to a 

softer color scheme of blues, creams, and grays.   
 

• New Menu Bar:  We have removed the icons along the top menu.   
 

• New Button Look:  The look of the buttons along the top of each window has 
now been updated.  We continue to support our existing button functionality such 
as turning buttons yellow when there is additional information behind them. 

 
• Screen Appearance:  A number of the screens have been improved to present the 

data in a more modularized form. 
 

• Java 1.6: - The client application and the server now run under Java 1.6.   
o Scroll Mouse:  Java 1.6 supports the use of the scroll mouse. 

 
o Type-Ahead with Combo Boxes: The default functionality of combo boxes 

in Java 1.6 supports the “Type-Ahead” feature.  This feature allows the 
program to select the next available match as the user types in a selection.  For 
example, if the combo has entries ‘Jack, Jones, Jollie’ and you type ‘Jo’, Jones 
will be displayed.  If you type ‘Jol’, Jollie will be displayed.  In previous 
version to get to the ‘Jollie’ selection you would have typed ‘JJJ’.   

 
o Installation of Java 1.6: The installation of Java 1.6 on the application server 

is handled by our Technical Services Department prior to your software 
update.  The client installation of Java is automatically updated after midnight 
if the user has not logged out (the PC can be left in a locked state).  To force 
the download of Java instantly on the client, use the menu item Help -> "Get 
Latest Version of Java”.  Once Java is installed the user must logon to the 
system.  To check the version of Java installed on the client use the menu item 
“About” and it will be listed next to  “Java Version” 

 
 

 Keyboard Shortcuts (File->Keyboard Shortcuts) 
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• User defined Keyboard Shortcuts are key combinations that duplicate menu 

selections. These default keys have been setup by the system:  
Ctrl-P = Patient Registration  
Ctrl-I = Inquiry 
Ctrl-B = Bookings 
Ctrl-H = Charge Posting 
Ctrl-R = Credit Posting 
Ctrl-D = Daysheet 
Ctrl-G = Report Generator 

  
Users may also over-ride these settings and set their own keyboard shortcuts for areas 
of the system they use often. To add additional keyboard shortcuts go to File-
>Keyboard Shortcuts.  The screen will display a table of all menu items that the user 
has permission to access.  To change or set the keyboard shortcut, select the item 
from the table and then either double-click on it or select the “modify” button from 
the button bar.  A small window will open up allowing you to enter in a key-
combination.   
 

Keyboard Shortcuts can include any of the following: 
1. Function Key (F1-F12) 
2. CTRL+<Number> 
3. CTRL+<Letter> 
4. CTRL+Function Key 
5. CTRL+SHIFT+Function Key 
6. CTRL+ALT+Function Key 
Exclusions: CTRL+A, CTRL+C, CTRL+V, CTRL+X, CTRL+Z, ALT+<any 
key> 
 

If the key combination does not appear, it is not an allowed key combination. 
Once you have selected a valid key combination, it will appear in the field on the 
screen. Select okay or cancel to exit the window.  When you have set all the keyboard 
combinations select the "Save" button.   
 

 
 Patient Registration Enhancements   

• Patient Name:  The Patient’s name and number are now displayed in bold letters. 
 

• Default Registration Provider:  In User File Maintenance there is now a 
separate Default Provider selection that will be used as the default provider when 
adding patients.  Prior to this the system was using the default scheduling 
provider.  

 
• DL-Num: This field has been expanded to hold 20 characters. 
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• Display of Fee Level on Extended Panel (Community Health Center 

enabled):  If the patient has a billable insurance plan, the current fee level step 
will now display next to the family size and there will be an indicator in red above 
the field stating that the patient does have insurance (*Patient has Insurance).  

 
• Family Cell Number on Guarantor Panel – The cell number has been added to 

the guarantor panel.  
 

• Patient Insurance - Insurance Display:  Additional information is now visible.  
This includes Policy Holder complete address (address, city, state, and zip), 
Policy Holder sex, Policy Holder SSN, Insurance Plan NEIC number, Insurance 
Plan Electronic Eligibility (Y or N value), Crossover (Y or N value), and the first 
100 characters of the Insurance Comment. 

 
• Charge Review –Claims can now be viewed from the Charge Review screen by 

selecting the ‘Claims’ button.  This will allow users the opportunity to review 
claims that get marked for rebill after the insurance plan has been updated on the 
charge.  If the system detects that unpaid claims have been marked for rebill, a 
window will pop up asking the user if they would like to review the claims.  If 
‘Yes’ is selected the claim window will be displayed.  It is important to remember 
that claims do not get marked for rebill until the insurance changes have been 
saved.  To save your changes select the ‘Save’ button.  To close the Charge 
Review window use the ‘Exit’ button.   

 
 

 Eligibility Enhancement  
 

• Filtered View of Deductibles, Co-Insurances, or Co-Payments:  When viewing 
an eligibility inquiry you can use the dropdown to view just the Deductibles, Co-
Insurances, or Co-Payments. 

 
• Filtered View of Service Types:  When viewing an eligibility inquiry you can 

use the dropdown to view benefits only of a certain Service Type.  The dropdown 
will only offer Service Types that are actually available on the specific inquiry 
you are viewing.   The default is “All Service Types.”  This dropdown works in 
conjunction with the Benefits dropdown that allows you to isolate out deductibles, 
co-insurances, etc. 

 
 

 Inquiry Enhancements   
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• Display of Patient’s Age:  The patient’s age will now be displayed next to the 
Date of Birth field.  If the patient’s age is less then 2 years the field will be 
displayed in months. 

 
• Main Info Panel:  The Work Phone number is now displayed.  

 
• Guarantor Panel:  Additional information has been added to this panel.  This 

includes the Cell Phone, Employer, Social Security number, Date of Birth, Sex, 
and Email address of the guarantor. 

 
• Other Info Panel:  The Send Mail value of YES, NO, or SPECIAL will be 

displayed. 
 

• Extended Info Panel (Community Health Center enabled): A panel with 
information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

 
• Insurance Display:  Additional information is now visible.  This includes the 

Policy Holder complete address (address, city, state, and zip), Policy Holder sex, 
Policy Holder SSN, Insurance Plan NEIC number, Insurance Plan Electronic 
Eligibility (Y or N value), Crossover (Y or N value) and the first 100 characters of 
the Insurance Comment. 

 
• Use the “+” key instead of “c” when searching by claim number: You can 

now use the “+” key followed by the claim number to search for claims.  This will 
keep the users hand on the 10 key pad when typing in the claim number.  For 
example if you want to bring up claim number 12345 you could use the format 
+12345  

 
• Search by claim number:  If a claim number is used to bring up the account 

using the format  c<claim #> or +<claim#>  followed by an Enter Key,  the 
inquiry window will load the claim information and the associated audit entries.  
This will be the same as if the user had selected the claim out of the claim 
selection window.  If you want to display all transactions instead of the specific 
claim use the search button or Alt + s after typing in the claim number.    

 
 

• Re-display of Collection Alert Window:  The "Notes" button on all of the 
screens that display patient notes will now have a plus sign on the button 
(“Notes+") if there are collection notes associated with the account displayed.  To 
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access the Collections Alert window, you can right click on the button and select 
“Collections Alert” and the alert window will be displayed.  

  
• Collection Alert window – ability to add additional notes:  From the 

Collection Alert window – Notes button, users may now add additional collection 
notes.  Existing Collection Notes may not be deleted or changed.  This feature is 
permission-based and the user must have the correct permissions set in 
Permission File Maintenance – Group: Collections Items: Add Notes.  

 
• Statement History:  The Statement history panel will now store not only monthly 

statements but any demand statements that are produced by the system.  There is a 
new Type column that will indicate if it is a demand or monthly statement. 

 
 Claim Detail Window:   

• Included Archived checkbox:  If claims have been archived, they will not 
appear in the window unless the checkbox “Include Archived” is selected.  The 
Mode column will display the word “Archived” for all archived claims. 

 
• Buttons Renamed: The “Notes” button has been renamed to “Coll Notes”.  The 

“Detail” button has been renamed to “Reprint Detail” 
 

• Ability to view and print Electronic processed ERA files at the claim level:  
There is now a ‘View ERA’ button in the Claim Detail screen that will display 
any electronic remittance advices that were processed through Remittance and 
posted to the claim.  A new column on the Claim Detail Screen labeled “Remit” 
will have a “Y” in the column if there is one or more stored ERAs attached to the 
claim.   The Electronic Remittance Advices screen will display in a table all ERA 
files that have been processed against this claim.  The columns displayed include 
Process Date, Pay Provider, Check Number, Source File and Process By.  By 
default the first ERA in the table will be selected and displayed in the lower half 
of the screen.  You can click on any ERA entry and the full ERA will be 
displayed in the lower half of the screen.   To print one or more entries in the 
table, select them from the table and hit the “Print” button.   

 
• Account number displayed: The account number is now displayed on the left 

hand side of the screen. 
 

 Charge Posting Enhancements 
• Calculate Quantity by Days:  There is a new checkbox in Procedure File 

Maintenance labeled “Calc Qty by Days”.  If this checkbox is selected and the 
procedure is posted, the quantity in Charge Posting will be completed for the user.  
The calculation will be based on the beginning service date through the ending 
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service date.  For example, if the beginning date is 01/01/2007 and the ending 
date is 01/03/2007, the quantity would be set to 3.  

 
• Self Referral:  There is a new checkbox in Procedure File Maintenance labeled 

“Self Referral”.  If this checkbox is selected and the procedure is posted, the 
referring physician will automatically be populated based on the rendering 
provider selected on the charge.  The rendering provider must be set up in the 
system with the checkbox “Appear in Referring Provider Selections” enabled 
(Provider File Maintenance) for the referring provider name to be populated.  As 
with all procedure selections, this can be set up on specific Financial Class entries 
if needed.    

 
• Display of Patient’s Age:  The patient’s age will now be displayed next to the 

Date of Birth field.  If the patient’s age is less then 2 years the field will be 
displayed in months. 

 
• Main Info Panel:  The Work Phone number, Date First Seen, and Date Last Seen 

are displayed on the main panel.  
 

• Insurance Display:  Additional information is now visible.  This includes Policy 
Holder complete address (address, city, state, and zip), Policy Holder sex, Policy 
Holder SSN, Insurance Plan NEIC number, Insurance Plan Electronic Eligibility 
(Y or N value), Crossover (Y or N value) and the first 100 characters of the 
Insurance Comment. 

 
• Capitation enhancement – Ability to store the true Allowed Amount on 

Capitation Carve-out procedures where a capitation adjustment should not 
be posted.   In Procedure File Maintenance there is a check box “Cap No Adjust” 
that can be set on capitated entries where the system would post a capitated 
adjustment.  This is typically considered a “Carve Out”.  Prior to this 
enhancement the system calculated the adjustment amount as the charge amount – 
the allowed amount.  In the case were there would be no adjustment, the full 
charge amount was put in the Allowed Amount field.  With this enhancement the 
Allowed Amount can hold the true Allowed Amount and this checkbox “Cap No 
Adjust” can be used as the indicator to post a capitated adjustment. 

 
• Visit Information – Screen Validations through Screen Entry Control 

(Community Health Centers only): Screen validation now controllable through 
Screen Entry Control File Maintenance (Billing->File Maintenance->Screen 
Entry Control) for the Visit Information screen.   In Screen Entry Control File 
Maintenance, choose the CHARGE POSTING_CVR screen to set the screen 
items as Required, Optional or Warning.   NOTE: some screen items are not 
found in Screen Entry Controls because they must always remain required. 
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• UB Panel Defaults:  In General Code File Maintenance (Billing->File 
Maintenance->General Codes) you can specify default value(s) for Admission 
Source, Admission Type, Condition Code, Occurrence Code and Patient Status by 
placing a value of ‘1’ in the Rank field.  If a ‘1’is entered in the Rank field, the 
value specified in the description field will default for that corresponding field in 
Charge Posting – UB panel when posting a UB service.  If the patient’s previous 
date of service included a UB service then the defaults are pulled from that visit.  

 
 

 Credit Posting Enhancements 
 

• Use the “+” key instead of “c” when searching by claim number: You can 
now use the “+” key followed by the claim number to search for claims.  This will 
keep the users hand on the 10 key pad when typing in the claim number.  For 
example, if you want to bring up claim number 12345 you could use the format 
+12345.  

 
• Post by claim number:  If a claim number is used to bring up the account using 

the format  c<claim #> or +<claim#>  followed by an Enter Key,  the credit 
posting screen will default the credit type, insurance plan, and claim date based on 
information obtained from the claim.  The claim number will be displayed above 
the claim date.  Once the claim button is selected, the charges associated with the 
claim will be automatically loaded.  You will not need to select the claim out of 
the claim window.  If you want the system to NOT default to the specific claim 
but still select the patient based on the claim number, use the search button or Alt 
+ s after typing in the claim number.    

 
• Denial Tab:  When posting to the claim, the cursor will go to the denial tab after 

entering through the fields on the copay /deductible tab. 
 

• Original Denial Description:  If a denial was previously posted to the claim, the 
denial code and description will appear above the denial field. 

 
• Responsibility Warning:  During claim posting, if one or more services are 

switched manually to Insurance Responsibility, but the system has determined 
that the charges should be at Patient Responsibility (the claim has not been 
flagged as denied and all appropriate insurance plans have paid as specified by the 
Patient Responsibility indicator of the Financial Class) the following warning 
message will appear: "Possible denial code on payment missing due to charges 
still at Insurance responsibility. Do you wish to correct?” 
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• Display of Patient’s Age:  The patient’s age will now be displayed next to the 
Date of Birth field.  If the patient’s age is less then 2 years the field will be 
displayed in months. 

 
• Main Info Panel:  The Work Phone number, Date First Seen, and Date Last Seen 

are displayed on the main panel.  
 

• Insurance Display: Additional information is now visible.  This includes the 
Policy Holder complete address (address, city, state, and zip), Policy Holder sex, 
Policy Holder SSN, Insurance Plan NEIC number, Insurance Plan Electronic 
Eligibility (Y or N value), Crossover (Y or N value) and the first 100 characters of 
the Insurance Comment. 

 
• Print Alternate Claim: There is now the ability to generate an alternate hardcopy 

claim from Credit Posting.  The checkbox “Prt Alt Clm” will display at the 
bottom of the screen if there is alternate coverage on the selected charges.  If a 
alternate claim already exists for the charges you are posting against and the “Prt 
Alt Clm” is selected, the alternate claim will be reprinted   In the tool tip you will 
be able to see the previous generated claim by placing your mouse over the 
checkbox “Prt Alt Clm”.  If you wish to just mark the alternate claim for reprint 
use the “MRP” checkbox. 

 
 Write-Offs:  (Billing->Posting-Write-offs): The program will now allow any credit-

code type to be specified when using a negative amount balance range. It will give a 
warning and ask you to continue, if you don't enter a refund credit code for a negative 
amount range. 

 
 

 Daysheet Batch Review:  The Daysheet Batch Review will allow users to review 
on-screen all transactions posted in an open or cleared batch.  This feature will be helpful 
when trying to balance Daysheets.  It also can be useful when trying to track down 
information related to charges or payments within a batch.   The user can sort by any 
columns in the table (see Viewable Data below for list of the field names), and can isolate 
out transaction types to view (Charges, Payments, Adjustments or Refunds).  This screen 
can also be used to verify that all necessary data has been posted.  For example, when 
filtering by charges, and varying the sort, the user can verify that all charges have been 
posted to the correct Provider (sort by Provider), or the correct Department (sort by 
Department), or by verifying authorization numbers entered (sort by Authorization 
number or Procedure), or by verifying that the correct place of service location was 
entered (sort by POS code).   
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• Access to the Daysheet Batch Review – This feature is accessed from Billing-
>Posting->Daysheet Batch Review or by using the right mouse menu on the 
Batch button in Charge Posting, Credit Posting, Reversal Posting, or Remittance. 

 
• Ability to select Batches – To select one or more batches use the “Load Batch” 

button on the button bar.  This button will only appear if the Daysheet Batch 
Review is accessed from the Posting menu.  The radio button will default to 
“Open Batches” for the user and the most recent opened batch will be selected.   
To select a cleared batch, select the radio button “Cleared Batches’, and enter in 
the date range the batch was cleared, then select the “Load” button.  A list of 
batches will be displayed on the right side of the screen.  If the User Selection or 
Batch Selection is changed the user must select the “Load” button to have the 
system redisplay the list of available batches.  Once the correct batch or batches is 
selected on the right side, hit the “OK” to select.  All transactions for the selected 
batches will be displayed.     NOTE: ** If the Daysheet Batch Review is accessed 
from the “Batch” button, the users open batch will be the selected batch and can 
not be changed.   

 
 

• Viewable Data – In the upper portion of the screen, the batch name and batch 
totals will be displayed. Fields displayed for the transactions include Batch Name, 
Batch User, Date Batch Opened,  Date Batch Cleared,  Charge Ticket Number,  
Date Entered, Date of Service/Payment Date, Account number,  Patient’s Name, 
Procedure/ Payment type, Reversal Status,  Financial Class/ Denial Code,  DX-1 / 
Check number and Aba 1,  Charge Amount/ Payment Amount,  Authorization 
Number, Department, Provider, 2nd Provider, Referring Provider,  POS code,  
Hospital, Admit, ECS Comment, Qty, DX-2, DX-3, DX-4, Insurance Plan, Onset 
Date,  Discharge Date, General Comment, End Date, Primary Ins Effective Begin 
Date and  Remain Amount. 

 
• View transaction in the Payment or Charge Detail Screen - The user can 

double click on a transaction to modify fields within the Charge or Payment detail 
screens. 

 
•  View audit trail for transaction - The audit trail can be viewed by right mouse 

clicking on a transaction.  
 

• View Transactions by Type - By using the checkboxes near the top of the screen 
the user can select to view any combination of transaction types (charges, 
payments, adjustments and or refunds).  

 
• View Patient in the Inquiry Screen – The Inquiry button takes the user directly 

to the Inquiry screen and will display the patient based on the transaction initially 



 
Release Notes Version 20 

 

 
- 10 -

selected in the Daysheet Batch Review. Once the exit button is selected in 
Inquiry, the program automatically goes back to the Batch Review. 

 
• Reversal Posting screen - The Reversal button takes the user to Reversal Posting 

and will display the patient and transaction selected.  If an open batch was chosen 
in the Daysheet Batch Review, that batch will be automatically selected in the 
Reversal Posting screen.   Once the exit button is selected in Reversals, the 
program automatically goes back to the Daysheet Batch Review and reflects any 
Reversals posted. 

 
• Ability to move transactions from one open batch to another open batch. – 

The “‘Move” button will move selected transactions from one open batch to 
another open batch.  This ‘Move’ button will only appear if a single open batch is 
selected.  Once the user hits the Move button the Batch Posting window will open 
allowing the user to select the receiving batch open batch.  It will warn you if you 
have selected the current batch. 

 
 

 Remittance Enhancement  
• New Exception Report:  There is now an option to open a report that will display 

only the exceptions (claims with errors) after processing. The Exception report is 
exactly like the full Remittance report except that the detail sections only show the 
claims that had exceptions.   These are the same claims that appear on the Exceptions 
List page (Provider Summary section).   There are two new checkboxes in the 
remittance program, “Open Full Report” and “Open Exception Report” that 
determine which reports are opened after processing.  By default, the “Open Full 
Report” is checked and the “Open Exception Report” is not.   The system will still 
create the full report even if you choose to only open the exception report.  The 
format of the file names are as follows:  

  Full Report: <remit filename>.html 
 Exception Report: <remit filename>.exc.html 

 
• Storing of Remittance Advice in the database: The electronic remittance advices 

that have been processed are now stored within the database and can be viewed and 
printed at the claim level in the claim detail screen.  

 
 

 Patient Notes Types (Billing->File Maintenance->Patient Note Types) 
• New Patient Note Types can now be created by your Practice.   The new Type 

will be associated with a specified color and can optionally be assigned an Alert 
status.  To define a Patient Note Type with an Alert status you must determine the 
screens in which the notes will pop-up as Alerts.   The existing Patient Note 
Types (in yellow below) of “ALERT”, “ALERT MAIL”, “ALERT PHONE”, 
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“INTERNAL”, “STMT”, “STMT ONCE”, “STMT PRINTED” are considered 
System defined Note types and the Patient Note Type description can not be 
changed.  However, you are free to change the color and Alert status.  

 

 
 
 
• To add a new Patient Note Type go to Billing->File Maintenance->Patient Note 

Types and select the “New” button.  Enter in a Note Type description and select a 
color.  If you would like the notes entered with this Note Type to pop up as Alerts 
you must also then select one or more of the checkboxes in the alert section.  
Select the “Save” button to accept.   

 
• To modify an existing Patient Note Type, select the Note Type on the left side of 

the screen.   The stored information will be displayed on the right.  After making 
your selections, hit the “Save” button to accept. 

 
• To Add, Modify, or Delete Predefined Notes use the selections on the lower half 

of the screen.  Predefined Notes can be used when adding patient notes by right 
mouse clicking in the free text area.  (The setup of Predefined Notes was 
previously done in General Codes File Maintenance).  Use the “Save” button to 
save your additions or modifications.  

 
 Denial Code File Maintenance  
• Group and Reason Code – The Group Code and Reason Code have been added to 

the first screen of Denial Code File Maintenance. 
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 Credit Code File Maintenance  
• Group and Reason Code – The Adjustment Type, Group Code and Reason code 

have been added to the first seen of the Adjustment Code View screen.  
  
 

 Procedure File Maintenance Enhancements  
• Start Date:  New Procedures (or alternates) can now be added that have a start 

date in the past. This will NOT update charges that were posted in that date range.  
When modifying procedures with a future start date, you can not change the start 
date to the past. 

 
• Calculate Quantity by Days:  There is a checkbox labeled “Calc Qty by Days”.  

If this checkbox is selected and the procedure is posted, the quantity in Charge 
Posting will be completed for the user (see additional information under the 
Charge Posting section).   

 
• Self Referral:  There is a checkbox labeled “Self Referral”.  If this checkbox is 

selected and the procedure is posted, the referring physician will automatically be 
populated based on the rendering provider selected on the charge (see additional 
information under the Charge Posting section).   

 
• Drug Selection: If the procedure selected is linked to a Drug specified in Drug 

Table (RX->File Maintenance->Drugs) it will now be displayed on the based 
procedure.  This will also allow a procedure to be linked to a Drug, if it was not 
originally specified during the initial setup of the procedure. 

 
 
 
 

 Fee Schedule Import: (Billing->File Maintenance->Procedure File Maintenance-> 
FeeSched Import) 

Fee schedule changes can now be automatically applied against your Procedure table 
from a CSV file (comma delimited (*.csv) - a selectable format within Excel).  This 
update can be applied against a Financial Class, Provider, Department, Insurance 
Plan, or the base entries.  This file can be provided by the payer or it can be created 
based on your existing fee schedule and then modified within Excel. The fields 
available to be updated include the allowed amount, charge amount, paid at percent, 
quantity, and units.   
 
• “Export File” button:  To create a CSV file based on your existing procedure 

file, select the “Export File” button.  If you would like to isolate specific alternate 
entries, that can be done by optionally selecting the financial class, insurance 
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plan, department, and/or provider of the procedures and then selecting “Export 
File”.   If you do not make a selection you will be creating a file of your base 
entries.  Once you select the "Export File" button, the program will ask you to 
enter the file name and select the directory in which to save your file (i.e.  
Medicare_fees.csv).  You can then edit the file within Excel to make your 
changes and when done, save the file as a .csv file.  You may want to name the 
file to reflect that this has the new fees (i.e. Medicare_fees_01_2008.csv).   This 
file would then be selected in the “Load File” routine.  

 
• “Import File” button:  Select the file you wish to import by pressing the "Import 

File" button. This is the file that will be used to automatically create the new fee 
schedules. (This is similar to going into Procedure File Maintenance, selecting a 
procedure and hitting the “Schedule Change” button, then entering in a starting 
effective date and new allowed amount.)  You should be selecting a saved CSV 
file (comma delimited (*.csv) - a selectable format within Excel) from the correct 
directory.   The system will then load the file and display the various fields within 
the grid.   

 
• Format of the file:  At the top of the file (before any CPT entry lines) there must 

be a header row that contains at a minimum, the word ‘CPT’ and ‘ALLOWED’. If 
there are additional fields you want to update they must also be in the header but 
in this specific order:  CHARGE, PAID_AT_PERCENT, QUANTITY, UNITS. 
(See example of e-Medsys file below.)  The PROCUDURE NUMBER column is 
optional and is used to facilitate tracking down the correct procedure during the 
update.  If one field is missing everything else is ignored.  Except for the field that 
contains the CPT the values may be blank.  If a field is blank, the existing 
procedure values will be used.   If a row starts with “#” it will be ignored. If the 
first row starts with “e-Medsys” this line is ignored. (see example of first row in 
e-Medsys file below).  The start of each valid CPT can optionally start with 
“CPT:”; this is allowed because Excel may try to remove leading zeros from 
numbers and then the update will not be able to identify CPT code values that 
begin with leading zeros. 

 
                      Example file from Payer 

CPT ALLOWED 
99211 23.39
99212 41.5
99213 56.24

 
Example file from e-Medsys  
e-Medsys Procedure dump FC: MEDICARE  Ins: ALL Dept: ALL Prov: ALL  
CPT ALLOWED CHARGE PAID_AT_PERCENT QUANTITY UNIT
CPT:99215 114.74 176 80 1 3.1
CPT:99212 41.50 48 80 1  
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• Making the Correct Selections:  Once the file is loaded, select from the drop 

downs the Financial Class, Insurance plan, Provider, and or Department of the 
procedure alternates you wish to extend.  If nothing is selected the Base 
Procedures will be extended.  For example: If you are adding new Medicare 
procedures you would select Medicare from the Financial Class drop down.   If 
you want to use a base procedure, if an alternate procedure does not already exist, 
select the checkbox "Use Base if no Alternate exists".  Another example, if you 
did not have any Medicare Alternate fees currently loaded and you want to create 
Medicare alternates starting with your set of Base entries.  First you would create 
an export “Export” of all your bases, edit the entries in Excel to reflect the correct 
allowed amounts, and then “Import” the file. Next, you would enter the Medicare 
Financial Class in the Financial Class field, select the checkbox "Use Base if no 
alternates exist", and enter in a starting effective date. The start date indicates the 
effective begin date that would be used when creating the new alternates. You 
may select a date in the past, but previously posted charges will not be changed.  
You would then “Validate” the procedures displayed in the grid, then press the 
“Create button” to create the Medicare alternates. 

 
  

• “Validate” button: The Validate button determines the base set of values it will 
need for creating the new entries based on either the CPT value and/or the 
procedure number indicated. If problems are found they will be reported in the 
“Problem” column.  The other columns visible in the grid will be completed with 
data from the imported file or from the database.  The columns that begin with “F-
“ indicate the values in those columns are from the File.  The other column values 
are based on existing procedures.  The new entries will have the values indicated 
in the “F-“ columns unless the corresponding “F-“ field is blank.  .   

 
• White procedure row:  If the procedure row is white, the new entry 

will be created without any issues.  The “Problem” column will be 
blank.  

 
• Gray procedure row:  If the procedure row is gray, the entry will not 

be created because the system does not detect a change.  The Problem 
column field will say: "No Update Needed”.  When doing the Create, 
these rows will be skipped.   

 
• Red procedure row:   If the procedure row is red, there are problems 

with the procedure and the “Problem” column will describe what the 
issue is. Below are the possible error messages:  

• No existing Procedure Found with this CPT –This indicates 
that there is no matching CPT in the database. You 
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must manually create an alternate with this CPT or use the 
base entry if one exists (select checkbox "Use Base if no 
alternates exist"). 

• Found Multiple Procedures with this Number: This indicates 
that there is more than one matching procedure number in the 
database. You must manually fix this problem before it can be 
processed. This only will occur if procedure numbers are 
included in the imported file. 

• Found FUTURE procedures with this Number: This indicates 
that there is a matching procedure number in the database with 
a future date that would cause a collision. You 
must manually alter this procedure number. 

•  Found FUTURE procedures with this CPT: This indicates 
that there is a matching CPT in the database with a future date 
that would cause a collision. You must manually alter this 
CPT. 

• Repeated CPT:  This indicates that there is more than one 
procedure assigned to the CPT code and the program can not 
distinguish to update the correct one.  You must manually alter 
this procedure number. 

• Procedure is inactive:  This indicates that there is an inactive 
procedure/CPT found that must be re-activated before the 
system can automatically update.   

 
• “Create Problem File” button:  You can dump a .csv file of your problem list 

by selecting the "Create Problem File" button.    The problem file will be in the 
same format as the dump file (the fields you see on the screen) and it also includes 
the problem field. This can be used to work the problem list. It will only list the 
rows that have a problem. 

 
• “Clear” button:  If you would like to clear the problem list and re-validate, 

push the "Clear" button and possibly select another Financial Class, Insurance 
Plan, etc… then use the "Validate" again to create a new problem list.  

 
 

• “Create” button:  If you are ready to create the entries, select the "Create" 
button.  The screen will come up showing your selections then ask if you want to 
continue. It then creates a backup of your existing procedure table in the database 
called BACKUP_PROCS_<COMPANY_ID>_<yyyymmddhhmi>. Once that is 
complete the new procedures will be created. 
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 Insurance Plan File Maintenance 
• Financial Class change:  If the Financial Class is changed on an Insurance Plan, 

you will now be prompted to update all open charges and claims with this 
Insurance Plan to the new Financial Class selection.  It is recommended that you 
do this update as it will insure that your claims get the correct provider numbers. 

 
 Input List (Patient or Claim)  

• Ability to use a CSV file as an import for Input Lists:  On the patient panel and 
claim panel under the “Input List” button, there is now the ability to import a CSV 
file (comma delimited (*.CSV) - a selectable format within Excel) of Patient 
numbers or Claim numbers to be used in the input list.  If you are creating a new 
list by selecting the “Add” button or modifying a list by selecting the “Modify” 
button there is a new button “Import”.  If you use this selection you must then 
navigate to the directory where you have your CSV file stored and select the file.  
The format of this file is a single column list of Patient numbers / Family numbers 
(family systems), or claim numbers, depending on the type of input list you are 
creating. For example, below is a list of patient numbers:  

 
1 
4 
5 

10 
200 
300 

 
 

 Claim Input List – Mark for Reprint feature 
• Claims in an input list can be automatically marked for reprint – To use this 

feature go to Billing->Insurance->(select your Claim Type) ->Claim Panel. Select 
the “Input List” button and there will be a new option to mark claims for reprint 
based on an input list.  Select the list you are interested in and hit the button 
“Mark for Reprint”.  All claims within the list will be automatically marked for 
reprint.   If you would like to mark all claims for reprint that were within a 
particular batch or financial class, use one of the Reports under the Report 
Generator -> Claims category to select the specific claims, then import these 
claims into an input list (as described above) and mark these same claims for 
reprint.   

 
 

 Provider File Maintenance – Referring Provider 
• Copy a Referring Provider into the General Organization table (Primary 

Care Provider):  Each time you ADD a Referring Provider, you will now be 
prompted whether to copy this provider into the General Organization table as a 
Primary Care Provider.  NOTE: you will only receive this prompt if you have the 
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“Display Primary Care Provider” checkbox enabled in Company File 
Maintenance. 

 
 
 

 Revenue Period File Maintenance  
• Ability to re-open a month that was closed prematurely:  there is a new “Re-

open” button that will allow you to re-open the month directly proceeding the 
currently open month.   The system allows a maximum of two months to be open 
at once, so to re-open you must have only one month currently open.  NOTE: any 
new posting to the re-opened month will effect the month end totals for that 
month, so you would need to re-run your month end reports. 

 
  

 Report Enhancements  
• Reports Options:  If selections are made that include the selection of multiple 

Providers, Departments, Financial Classes, Patient Codes, Referring Providers, or 
Insurance plans, the options page will now list the various selection names.   If 
the selection includes Providers or Departments, the corresponding short name 
will print.  

 
• Report Templates will display User Name:  On the Template panel, when 

selecting a Template, the window will now display the user who created the 
template.  To search for a template, you can click on the column heading to sort 
by Template name or by User Name.  

 
• Update existing Report Templates:  An update to an existing report template 

can only be done if you were the creator of the template or have an administrator 
login.  If you do not have permissions, a message will appear informing you that 
the template name already exists and to enter in a new name. This will create a 
new template. 

  
• Account Activity Report:  There is a new checkbox "Filter by Selections" under 

the Charges dropdown. If this is selected, then the charges will be filtered by the 
other selections, i.e., Department, Physician. 

 
• “OK” button replaced with “Print” or “Run”:  To distinguish whether the 

system is “processing” or “processing and printing” the button “OK” has been 
replaced with “Run” or “Print” throughout the system. 

 
• Printer Selection Window:  If you hit the “Cancel” button in the printer 

selection window, the program will now return to the main selection screen.  
Prior to this it would exit from the report. 
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• Standard AR Reports – Suppression of inactive Financial Classes and Credit 

Codes and Providers: Age Analysis, Daysheet, Outstanding Claims, and 
Provider Productivity reports: inactive Financial Classes and Credit Codes that 
have no totals are now suppressed from the totals sections. 

 
 
 

 Daysheet Report :  On the detail panel, if the Reprint Date Range is entered, the 
system will warn you if you are selecting a date range that is greater than 31 days.  

 
 

 Patient Profile by Proc/Diag and Visit user Statistics (Community 
Heath Center Feature) 

• A new cross tab has been added: School Profile. 
• Only selected Financial Classes and Departments will appear in the crosstabs. 

 
 

 General Codes  
• Age Bracket (Community Heath Center Feature) : The description field in the 

age bracket category has been expanded to hold up to 180 characters. 
 

• e-Chart Category – Flatbed option:  There is now the option to set the default 
scan from the flatbed in e-chart File Maintenance.  This is important when using a 
scanner that has both a flatbed and an automatic document feeder.  To 
automatically enable the flatbed checkbox when scanning documents.  This will 
be important when using a scanner that has both a flatbed and an automatic 
document feeder.  The code field in e-Chart Category now holds an additional 
field for the flatbed default. The code field holds   <scanning size>,<sides>,<use-
popup>,<flatbed> 

 
 

Review of e-Chart Category setup in General Code File  
1. Complete the Description of e-chart category 

 
2. Complete the Code field (i.e. Code= 1,2,Y,Y)  A comma should be used to 

separate the values <scanning size>,<sides>,<use-popup>,<flatbed> 
 

• <scanning size>: Enter a value of 1, 2, 3, 4 or 5.  This value 
corresponds to the e-Chart scanning size  
1 = Business Card(3.5 x 2)  
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2 = (5 x 3) 
3= (6 x 4) 
4 = (4 x 6)   
5 = Standard(8.5 x 11) 

 
• <sides>: Enter a value of 1 or 2.  A value of 1 for single side scanning 

or a value of 2 for duplex scanning.  If no value is specified the value 
of “1” is assumed.  

 
• <use-popup>: Enter a Y or N to indicate the use of the popup control. 

If no value is specified the value of “N” is assumed.  
 

• <flatbed>: Enter a Y or N to indicate the use of  a flatbed. If no value 
is specified the value of “N” is assumed.  

 
3. Complete the Code2 field (i.e. 1,50,25):  The code2 field is a comma 

separated list <resolution>, <brightness>, <contrast> 
 

• <resolution>: Enter a value of 1, 2, 3.  This value corresponds to the  
1 = 75 
2 = 150 
3 = 300 
 

• <brightness>: The value should be between 1-999.  If no value is 
specified the default is set to 700. 

 
• <contrast>: The value should be between 1–999.  If no value is 

specified the default is set to 350. 
   

4. Complete the Rank field - The rank field is used to control the sorting order of 
the categories. 

 
 Insurance Enhancements  

•  (CMS 08-05) Show Specialty:  (Billing->File Maintenance->Insurance Plan File 
Maintenance)   There is a new checkbox in Insurance Plan File Maintenance – 
Rules Panel “Show Specialty (CMS 0805 NPI Only)” that defaults to include the 
Providers specialty code in box 17a, 24J, and 33b when the Provider Number 
Mode is set “NPI ONLY”. Once in this mode, if there are plans that request that 
these boxes be blank, you will need to uncheck this box.  

 
• Displayed Insurance Menu Items: The insurance menu items that appear under 

Billing->Insurance will always include ECS (ANSI) 997 and Emdeon ITS.  Any 
other form types that are displayed will be based on the entries defined in Billing-
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>File Maintenance->Insurance Control.  If any of the standard form types (CMS 
(08-05), CMS (UB-04), ECS (ANSI) 4010 or ECS (ANSI) 4010 ) are not defined 
in the Insurance Controls they will appeared grayed out in the menu.  This 
indicates to the practice that these form types are supported by the application. 

 
• Hardcopy Alternate Claim Runs - Option to Automatically Print Stored 

EOB’s:  When printing alternate insurance (HCFA 12-90, CMS 08-05) claims, 
you now can print the applicable EOB’s during the run.  To enable this feature 
select the “Print ERA’s” checkbox on the Fin Class/Ins Plan panel.  NOTE: you 
must not be using pre-printed forms.  Plain paper must be in the printer.  Once this 
feature is enabled, each claim will be immediately followed by any stored ERA’s 
that pertain to the previous payer’s claim.  Obviously, the more primary payers 
you have doing Remittance, the better.   ERA’s will begin being stored to your 
database once you have the v20 remittance program.  

 
• Billing with Hemoglobin levels (HGB levels):  Certain carriers are now 

requiring that the hemoglobin levels be sent in the ANSI 4010 - 2400 MEA 
record as opposed to being sent in the ECS comment. The insurance programs 
have been enhanced to supply this information from the ECS comment field.  
The ECS comment must be entered in one of the following formats: 

 
 HGB:10 

 
Note: If you would like to specify a line number for paper claims you can add 
additional comments after the value for example HGB:10 Line1  

 
o This format is identical to billing hematocrit levels in which the ECS 

comment format is   HCT: 33 
 
 

 Statement Enhancements    
• CSC Number:  If credit card information is printed on your statements, there 

will now be a place to enter in the 3 or 4 digit CSC (Card Security Code) number. 
 

• Check Number:  Patient payments that include a check number will now print 
on the statement starting in the ICD9 column.   If the statements are in “Show 
Audit” mode, the check number will also be included for any payment. 

 
•  Insurance Plan Information (Family System):  If the insurance plans are the 

same on all the charges on the statement, we now print the insurance plan names. 
 
  

 Admin 
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• Claim Archive:  Claim Archive is a new selection under the Admin menu. It marks 
claims in the selected date range as archived so they don't appear automatically in the 
Claim Selection Window.  The date range selection refers to the claim process date. 
As a precaution, the system will not allow you to remove claims that have been 
processed within the last 6 months. A date range must be selected before claims can 
be archived and only claims that have a transactions remaining amount of zero will 
qualify.   

 
 

 New Security Features 
• Password Reset Feature (User File Maintenance checkbox “Force Password 

Change Next Log in”):  This checkbox allows the Admin to force a password reset 
for a user.  Once this checkbox is checked for a user, on that user’s next log in, the 
Change Password Window will pop up with the message “The Administrator is 
requiring an immediate password change.”.  Once the user successfully changes the 
password, the program un-checks the checkbox automatically.   The user cannot gain 
access until the password has been changed. 

 
• Password Strength Rules (Permissions File Maintenance Password Options): 

 Min Length - the minimum number of characters for the password.  The 
default is 6.  The range is 6 – 14. 

 Min Nums - the minimum number of digits required in the password.  The 
default is 1.  The range is 1 – 13. 

 
• New parameter for Password Expiration Feature (Permissions File Maintenance 

Password Options "Recycle Days"): Definition: The number of days that must pass 
before a former password may be reused.  Default (Empty field):  a user of this role 
may never reuse a former password. 
 

• Logon Locking Feature (Company File Maintenance - Miscellaneous Options 
“Max Log In Attempts”):  This will allow the Admin to specify how many log in 
attempts a user gets before his Logon is locked out of the system.  If the user doesn’t 
succeed in logging in after this many attempts, the Logon Lock Date field is set in 
User File Maintenance for that account, and access from that point on is blocked.  
The Admin can then clear out the Logon Lock Date for that user when he sees fit.  
NOTE: A user’s Logon is not guaranteed unique within a given Company.  As a 
result, if a Logon needs to be locked, all users with that Logon are given the lock 
date.  When the Admin decides to clear out a user’s Lock Date in User File 
Maintenance, the system will check if more than the selected users are affected by 
the lock.  If so, a window pops up showing the other users, then asks if they still want 
to clear the Lock Date.   Upon confirmation, all the Lock Dates for those users are 
cleared. 
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• Inactivity Settings – Auto Logout and Locking of the e-Medsys Application: The 
Inactivity Settings are set at the role level which is specified under Admin-
>Permissions.  There is a section labeled “Inactivity Settings” where the administrator 
can establish by role the number of minutes that must pass where there is no activity 
within e-Medsys before users are automatically logged out of the application.  There 
is also an option to lock the application or provide a warning message if there is no 
activity within the specified amount of time. 

 
Inactivity setting options: 

 
1. If you want to automatically log a user out of e-Medsys and also issue a 

warning Message prior to the logout:  Set the “Warning Minutes” to the 
numbers of minutes that must pass before the users get an inactivity warning 
message with an option to continue working. Set the “Logout Minutes” to the 
number of inactivity minutes that must pass before the e-Medsys application 
will exit.  If the user does not respond to the inactivity warning message and 
the number of minutes specified in the “Logout Minutes” has passed the user 
will be automatically logged out of e-Medsys.    

 
2. If you want to automatically log a user out of e-Medsys and also lock the 

e-Medsys application prior to the logout:  Set the “Warning Minutes” to the 
numbers of minutes that must pass before the e-Medsys application becomes 
locked. Set the “Logout Minutes” to the number of inactivity minutes that 
must pass before the e-Medsys application will exit.  Once e-Medsys is locked 
a window will popup requiring the user’s password to be entered to unlock the 
application.  If the user does not respond and the number of minutes specified 
in the “Logout Minutes” has passed the user will be automatically logged out 
of e-Medsys. The user will have 3 attempts at getting the password typed in 
correctly before they are automatically logged out of e-Medsys. If the user 
selects the cancel button they will be automatically logged out. 

 
3. If you want to automatically log a user out of e-Medsys without issuing a 

lock or warning message:  Set the “Logout Minutes” to the number of 
inactivity minutes that must pass before the e-Medsys application will exit.  If 
there is no keyboard activity or database activity within the application and 
the number of minutes specified within the “Logout Minutes” has passed the 
user will be automatically logged out of e-Medsys. 

 
4. If you want to lock the e-Medsys application:  Set the “Warning Minutes” 

to the number of inactivity minutes that must pass before the e-Medsys 
application is locked.  Once e-Medsys is locked a window will pop-up 
requiring the user’s password to be entered to unlock the application.  The 
user will have 3 attempts at getting the password typed in correctly before 
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they are automatically logged out of e-Medsys.  If the user selects the cancel 
button they will be automatically logged out. 

 
 

• **Important NOTE:  If you are using the “Lock feature”, the application can 
become locked while the system is processing a report or any other process 
where there is no keyboard activity taking place within the e-Medsys 
application. This is an added security feature that will allow the application to 
become locked while continuing to process in the background.   The user will 
not be automatically logged out while when there is processing taking place 
within the application. 

 
  

 Miscellaneous  
• Warning Message:  A warning message will appear if the application is closed 

using the ‘X’ button on the main application window.  
 

• The Help Text has been updated and can now be downloaded to your PC:  To 
download the latest help files to your PC, use the menu item Help -> "Get Latest 
help”.  This may take a minute, but then the files will be automatically extracted on 
your PC.  

 
 

 Report Generator 
• Collection Audit Reports: Under the List “Collections” there is a set of audit reports 

that will allow the practice to monitor activity within the Collection module. 
 

 Collection Access - Selection of Date Range and Users. Tracks based on User 
Login how long staff members are working in the Collector Work Screen.  
Shows how many accounts worked and number of minutes each pool user 
worked their accounts. 

 
 Account Status – Selection of Date Range and Users. Displays the number of 

accounts worked that were placed in a tickler date test and the dollar amount 
placed at that step.   

 
 Accts worked by Pool Summary - Selection of Date Range and Users. Displays 

the number of accounts worked for each day in the date range by pool owner, 
pool name and the total dollar amount in each pool at the time and the balance 
today. 
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 Collections Pool Outcomes – Selection of Date Range and Users.  Displays 
outcomes selected for each day in the date range by pool owner, pool name, 
number of accounts worked and the total dollar amount worked. 

 
 Collection Pool Summary - Selection of Date Range and Users. Displays the 

number of accounts assigned to each pool owner along with the pool name and 
total dollar amount in the pool for each date in the range.  

 
 Tickler Date – Selection of Date. Gives a list of accounts that are at a tickler date 

test step and the assigned date falls after the selected date. 
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Collection Module  
 
 

 Collection Workscreen  
• Denied Capitated Claims in Collections:  This feature will allow Capitated 

Insurance claims to fall into collections when there is a denial code posted on the 
claim and the Capitated Financial Class has a starting insurance collection cycle with 
the delinquent amount set to 0.00.  The denial code used on the claim must also have 
a starting insurance collection cycle set up in Denial Code File Maintenance.  The 
claim will fall out of collections once the denial code is removed from the claim.  

 
• Save Default setting for Charges and Payments: You can right mouse click in the 

charge and payment selection area on the right hand side of the screen to save your 
default payment and charge view for the collection work screen. 

 
• Extended Info Panel (Community Health Center enabled): A panel with 

information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

 
 

 Collection Pools:  
• Default Owner:  In Pool File Maintenance there is a checkbox where you can set the 

collection tickler default pool owner.  If a collection tickler has not been worked in a 
pool yet, then the pool owners assigned to the tickler will be determined by the 
default pool.  This is the owner that is displayed in the Collect Alert screen and also 
the owner name that is printed on the collection letters. Only one pool, per collection 
type (Patient and Insurance) can be the default pool. 
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Recall Module 
 Protocol File Maintenance: 
• Visit Type / Protocol link:  In the Protocol File Maintenance (modify mode) there is 

now a button "Visit Types" that will allow Appointment Visit Types to be linked to 
Recall Protocols.  If Protocols are linked to a Visit Type, during processing (Process 
Existing or Recall Work Screen), the system will only advance the process date and 
update the tickler note with appointment information if it finds a matching 
appointment with the correct Visit Type.  The note that is added to the Recall Tickler 
will now include the Visit Type as part of the appointment information.   If Protocols 
are not linked, the system will assume any appointment is valid just as it did before 
the new enhancement. 

 
 Recall Work Screen: 
• Appointment Found:  If a patient is not displayed in the Recall Work Screen 

because an appointment has been found based on the setting in Pool File 
Maintenance (View Future Appointments, View Past Appointments), a message will 
now appear informing the user that the patient’s process date is being updated and 
the tickler will be skipped.   

• Other Info Panel:  The “Other Info” panel has been added to the display of patient 
information. 

• Extended Info Panel (Community Health Center enabled): A panel with 
information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

  
 Recall Tickler File Maintenance: 
• Extended Info Panel (Community Health Center enabled): A panel with 

information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

 
• Print Tickler: If one or more recall ticklers are selected and the “Print” button is 

pushed, a window will ask the user if the want to “Print Selected” or “Print All’.  The 
Print Selected will only print information regarding the highlighted recall tickers.  
The “Print All” will print information regarding all recall ticklers. 

 
• Recall Tickler Report – The user name is now included in the note section of the 

report.
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Appointment Scheduling 
 
 

 Appointment Booking window 
• Appt Cancel Reason:  When canceling an appointment there is now a field for 

the user to enter the cancellation reason. This is on the same window as the 
"patient cancel", “provider cancel" buttons.  The user may right click in the field 
to pull up the list of predefined values (which are set up in General Codes under 
Appt Cancel Reasons). This cancellation reason associated with the appointment 
can then be seen in the Appointment   Info window.   You can set permissions 
under Admin-> Permission to force users to enter in a cancel reason or use a pre-
defined cancel reason.  Be sure to add the reasons in General Code File 
Maintenance before setting these permissions.  

 Scheduling: Cancel Reason – Pre-Defined only 
 Scheduling: Cancel Reason Required 

 
• Patient Cell Number visible:  In one day at a time mode, the patient’s cell 

number will be visible following the work number.  The cell number will also be 
displayed in the appointment rollover. 

 
• Confirmed Appointments:  If an appointment has been confirmed, a check mark 

will appear to the left of the patient name on the Appointment Booking window.  
 
 

 Appointment Info window 
• Main Info Panel:  The patient’s age will now be displayed next to the Date of 

Birth field.  If the patient’s age is less the 2 years the field will be displayed in 
months.   Date First Seen and Date Last Seen are also displayed on the main 
panel.  

 
• Cancellation Reason:  In the appointment history table there is a new column 

that displays the Cancelled Reason for cancelled appointments.  To change the 
cancellation reason or cancel type (provider or patient), select the appointment 
and push the "Cancel" button.  

 
• Guarantor Panel:  Additional information has been added to this panel.  This 

includes the Cell Phone, Employer, Social Security number, Date of Birth, Sex, 
and Email address of the guarantor. 

 
• Other Info Panel:  The Send Mail value of YES, NO or SPECIAL will be 

displayed. 
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• Insurance Display:  Additional information is now visible.  This includes Policy 

Holder complete address (address, city, state, and zip), Policy Holder sex, Policy 
Holder SSN, Insurance Plan NEIC number, Insurance Plan Electronic Eligibility 
(Y or N value), Crossover (Y or N value) and the first 100 characters of the 
Insurance Comment. 

 
• Extended Info Panel (Community Health Center enabled): A panel with 

information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

 
• Re-display of Collection Alert Window:  The "Notes" button on all of the 

screens that display patient notes will now have a plus sign on the button 
(“Notes+") if there are collection notes associated with the account displayed.  To 
access the Collections Alert window you can right click on the button and select 
“Collections Alert” and the alert window will be displayed.  

  
• Collection Alert window – ability to add additional notes:  From the 

Collection Alert window  – Notes button, users may now add additional collection 
notes.  Existing Collection Notes may not be deleted or changed.  This feature is 
permission based and the user must have the correct permissions set in Permission 
File Maintenance – Group: Collections Items: Add Notes.  

 
• Statement History:  The Statement history panel will now store not only monthly 

statements but any demand statements that are produced by the system.  There is a 
new Type column that will indicate if it is a demand or monthly statement. 

 
 

 Visit Type File Maintenance Enhancements:  
•  Department/ Provider Filter: There are 2 new dropdowns for Department and 

Provider/Resource filtering.  
• Saving the highlighted Row:  If you are viewing or modifying a selected row, the 

program will now re-select the row after returning from the detail screen. 
 
 

 Waiting List: 
•  Delete Expired: There is a confirmation window that will come up once the 

“Deleted Expired” button is pushed. It will also shows the number of records that will 
be deleted. 
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Prescription Tacking Module 
 Prescription Work Screen: 
• Other Info Panel:  The “Other Info” panel has been added to the display of patient 

information. 
 

• Extended Info Panel (Community Health Center enabled): A panel with 
information from the Extended demographics in Patient Registration is now 
displayed. It includes Income, Family Size, Fee Level, County, Race, Ethnicity, 
Language, Employment Status, Highest Grade, Student Status, School, Entering 
Method, and No Reason Method. 

 
• No Refill Left - Prescription will be displayed in red if there are no remaining refills.  

 
• Prescription (New and Refill) from Charge Posting: In Company File Maintenance 

– Posting Panel there is a new checkbox labeled ‘Rx Tracking’.  If this is enabled, 
new prescriptions and refills can be created from Charge Posting when prescription 
procedures are posted.  The default value for Rx Tracking is enabled. 
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Bug Fixes  
 

 Statements:  If the service physician was chosen for the heading, it was not showing 
the degree. 

 
 Booking Appointment:  If an appointment is set to discharged, we now keep the user 

from canceling it. 
 

 Rescheduling Appointment:  If an appointment was added to the reschedule list, and 
if the template for that day was removed, when the appt was rescheduled the original 
appt was being left open instead of being removed (it should be removed because the 
template was removed).  This is now fixed. 

 
 Recall Work Screen:  The balance panel will now age based on the transactions and 

therefore will match the aging buckets as in other areas of the system. 
 

 Charge Posting: If a charge transaction is re-displayed by double clicking on the 
charge in the lower section of the screen and the Financial Class is switched on the 
charge, the procedure will be cleared and re-entered so that the correct charge amount 
and other data related to this procedure can be determined. 

 
 Charge Detail Screen (Community Heath Center enabled) – If a procedure was 

posted to the wrong date of service this date can not be changed in the charge detail 
screen.  The service must be reversed and re-posted. 


